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Using TNTatlas with X Windows

Before Getting Started
TNTatlas® is a free product available from MicroImages for viewing hierarchical
atlases prepared in TNTmips® with HyperIndex® Linker or for single layout
atlases.  There are two versions of TNTatlas: a native Windows product called
TNTatlas for Windows and a version that runs with MicroImages X Server (MI/
X) called TNTatlas.  Both versions make use of the same atlas data without
modification.

Prerequisite Skills  This booklet assumes you have completed the exercises in
Getting Started: Displaying Geospatial Data and Getting Started: Navigating.
Those exercises introduce essential skills and basic techniques that are not cov-
ered again here.  Please consult these booklets for any review you need.

Sample Data  The exercises in this booklet use sample data distributed with the
TNT products.  If you do not have access to a TNT products CD, you can down-
load the data from MicroImages’ web site. The exercises in this booklet use the
Project Files in the TNTATLAS directory of LITEDATA and the TNTatlas file (.atl) also
found there.  A read-write copy of sample data on your hard drive is not required
since atlases can be run with the data on CD-ROM.  Making a copy on your hard
drive will generally speed access, however.  To gain more experience with at-
lases, visit the Online Atlases portion of MicroImages’ web site.  The TNTclient
software used for viewing these atlases is similar to TNTatlas but does not use X
windows.

More Documentation  This booklet is intended only as an introduction to using
TNTatlas.  You may also wish to consult the TNTmips reference manual for
additional information (see the sections on HyperIndex).

TNTmips and TNTlite®  TNTmips comes in two versions: the professional ver-
sion and the free TNTlite version.  If you did not purchase the professional
version (which requires a software license key), TNTmips operates in TNTlite
mode, which limits the size of your project materials.  TNTatlas is also a free
product from MicroImages, but the size of objects viewed with TNTatlas is not
limited; you can view any information the atlas designer has provided for you.

It may be difficult to identify the important points in some illustrations without
a color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ web site.  The web site is also your source of the newest Get-
ting Started booklets on other topics.  You can download an installation guide,
sample data, and the latest version of TNTlite.

http://www.microimages.com

Merri P. Skrdla, Ph.D., 2 October 2001
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Welcome to TNTatlas
TNTatlas provides a means for small or widespread

distribution of atlases.  The recipient of an atlas on

CD-ROM has everything required to view the atlas.

MicroImages requires no payment for the distribu-

tion of data and software in this fashion.  Once the

viewing software (TNTatlas) has been installed, it

can be used to view any atlas or object in TNTmips’

RVC format.  Although TNTmips is required to con-

struct an atlas using HyperIndex Linker, anyone us-

ing TNTmips, TNTedit, TNTview, or TNTatlas can

access the atlases created (depending on permis-

sions).  Any of these products, except TNTatlas, can

be used to create a single layout atlas.

One example of widespread distribution of an atlas

on CD-ROM was the insertion of a street atlas of

Istanbul (in Turkish) in a popular magazine with a

distribution of about 30,000.  The atlas was so popu-

lar it was also distributed with a second issue of the

same magazine. Precision agriculture consulting

provides a good example of small atlas distribu-

tions in which only a single copy of an atlas may be

given out to the individual farmer so that he or she

may view all the imagery, vectors, and other data

collected for the land they farm.  In either case, the

recipient of the atlas can be viewing the associated

data within minutes of inserting the CD-ROM in

their computer.

Four booklets address different aspects of working

with atlases including assistance with atlas design

(Introduction to: Designing Electronic Atlases), at-

las assembly (Getting Started: Constructing a

HyperIndex), the scope of projects that can be un-

dertaken (A Case Study: MERLIN: Enterprise-wide

Geospatial Analysis), and an introduction to the fea-

tures of TNTserver and Clients.  This booklet and

its companion (Getting Started: Using TNTatlas for

Windows) are designed for people using TNTatlas

who were not involved in the design of the atlas and

may be unfamiliar with TNTmips.

STEPS

copy the files in the

TNTATLAS data collection to

your local drive

The exercises on pages 4–

6 show you how to open an

atlas and navigate in a vari-

ety of ways.  Page 7 de-

scribes layer visibility, while

page 8 discusses viewing

attributes.  Page 9 demon-

strates web links by at-

tribute.  Page 10 describes

interface features not al-

ready presented and page

11 provides more tips for

viewing single layout at-

lases.
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Installing and Launching TNTatlas
The first step in running TNTatlas is installing the
program.  If you have acquired an atlas on CD-ROM,
placing the disc in your CD drive should launch

the installation program.  It could also
launch an Adobe Acrobat or html document
with buttons that let you choose between
installation, running the atlas (if TNTatlas is
already installed), or other functions.  If you
are installing TNTatlas from a TNT products
CD, choose to install TNTlite and when you
come to the window with installation
choices, choose to install TNTatlas.

Installation is a simple procedure.  You simply read
the screens that come up and click on the Next or
Continue button until you are done with installa-
tion and you click Finish.  You do not have to reboot
your machine for installation to be completed, as
you do with many products.

During TNTatlas installation, an association
is established between the file that specifies
the atlas home page, which has a .atl exten-
sion, and the program that launches TNTatlas
so that double clicking on any .atl file will
open TNTatlas with the home page specified
by that file.  You can also launch TNTatlas by
double-clicking on its icon in the installed

location or choosing it from the MicroImages group
on the Start menu (Windows only).  If launched in
this manner, you need to use the File menu to open
an atlas (.atl, Open) or an object in RVC format (Open

Object).  If you received an atlas on CD-
ROM, the .atl should be at the root level of
the CD.  There is no .atl file at the root level
of the TNT products CD.

You are instructed here to open an atlas that is pro-
vided as part of the sample data for TNTlite.  You
should, of course, also open the atlas that came on
your CD if that is how you acquired TNTatlas.

A shortcut to
the installed
location is
created in
the Micro-
Images
folder for the
Start menu
(Windows).

TNTatlas can be used by
anyone with a computer
(Windows, Mac, UNIX,
LINUX) and CD-ROM drive.
You can substitute the Inter-
net and download of the
program and data for a CD-
ROM drive.

STEPS

install TNTatlas from
whatever source you
acquired it

launch TNTatlas

choose File / Open
from the TNTatlas
window and select
USA.ATL, which is in
the TNTATLAS folder you
copied
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TNTatlas Components
Three windows open when you launch TNTatlas
from an atl file: the TNTatlas view window, the TNT-
atlas Layer Manager, and the HyperIndex Naviga-
tor.  The latter two
windows do not
open until you
open an atl file or
an object if you
launched TNTatlas
by double-clicking
on the application.
The HyperIndex
Navigator window
is only open when
the HyperIndex
Navigator tool is
active.

A HyperIndex stack, or atlas, is a collection of
graphically and geographically related objects that
uses the HyperIndex Navigator for point and click
retrieval of objects from the hierarchical links es-
tablished with HyperIndex Linker.  An atlas can also
be a single layout that uses map scale controlled
visibility to reveal and hide different layers as you
zoom in and out.  In this case, you use the zoom
tools, not the HyperIndex Navigator, to discover the
breadth of information presented in the atlas.

The area of the parent object that contains a link to
the next level in a stack is called an index area.  You
can choose to show or hide the outlines of these
areas.  If you click where index ar-
eas overlap, the HyperIndex Link
Selection window opens to let you
choose which link you want.  The
index areas in this example are the
min/max boxes for each state be-
cause the links were created auto-
matically using georeference informa-
tion rather than individually for each polygon.

HyperIndex Navigator tool
Previous Level

Home Level

Show
HyperIndex
Navigator

HyperIndex
Navigator

STEPS

note that when you
pause the cursor over a
state, a DataTip with the
state name appears

in the view window,
choose Options / Hyper-
Index /  Show Index Ar-
eas

now toggle off the Show
Index Areas option

(Do the exercises through
p.10 without exiting.)

This field is referred to in
the exercise on p. 7

LegendView
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Navigating Down and Laterally
Many objects can be linked to the same parent ob-
ject.  In the atlas used for this exercise, the county
maps for each of the states have been linked to the
parent object (contiguous states of the USA).  When
you click on a state, its county map is displayed.

Lateral links exist between all objects linked to the
same parent object.  The arrows on the HyperIndex
Navigator window let you get to these laterally
linked objects without first returning to the parent
object.  If there are multiple objects in a particular
direction, left-clicking takes you to the closest ob-
ject, which is identified by the DataTip when you
pause the cursor over the button, and right-clicking
provides a list of all objects in that direction to
choose from.

Clicking on the Home Level button always takes
you to the level of the atlas you started at.  The
Previous Level button takes you one level up in the
hierarchy of the atlas.  You have only navigated
down one level in this exercise, so the Previous Level
and Home Level buttons will bring up the same
object.

When you click on a location that is covered by
multiple index areas, a window
opens that lists the descriptions
for all the index areas where you
clicked.  You then choose the link

you want to follow or cancel the navigation.  You
can elect to have this window open if there is just a
single link by turning on the Verify Selection toggle

button on the HyperIndex cascade
from the Options menu in the view
window.  Generally, it is a nuisance to
have to click [OK] each time you navi-
gate, but you may decide with some
atlases, particularly if you are running

on a slower machine, that you want to see the de-
scription of the link before displaying the object.

Vocabulary: The Home
Level is the first level of a
stack.  In a published atlas,
the Home Level is often a
graphic that introduces the
purpose of the atlas.  You
can begin where you want
when viewing a stack in
TNTatlas by choosing Open
Object rather than Open,
which makes the Home
Level the object displayed
when you begin navigating.

STEPS

with the HyperIndex
Navigator tool se-
lected, click in the middle
of Nebraska

note that all of the arrows
in the HyperIndex Navi-
gator window are now
active

click on the down-
and-right arrow

pause the cursor over
several counties noting
the county names pro-
vided by DataTip

right-click on the
up-and-left arrow,
note the choices,
and select one

click on the Home
Level icon button
either in the HyperIndex
Navigator window or on
the view window toolbar

click on the east-
ern border of Ne-
braska, then
choose Nebraska
county outlines
from the Hyper-
Index Link Selec-
tion window (you can
double-click on it or click
once then click [OK])
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Layer Visibility
STEPS

turn on index areas (see
p. 5 if necessary)

click on the index area in
Dawes county

click on Show Details for
Group 1

click on the Hide / Show
indicator for ROADS and
note the presence of the
new layer

change the entry in the
Scale field (see p. 5) to
42000 and press <en-
ter>

change the entry in
the Scale field to
55000 and press
<enter>

Two conditions may cause a layer to not be cur-
rently visible: the Hide / Show indicator is set to
hide and/or the layer has map scale controlled vis-
ibility and the current scale is outside the visible
range.  You can see if there are any hidden
layers by expanding the group it is in so
the layers are listed.  The Hide / Show icon
is immediately to the left of the layer name.
Many atlases, particularly single layout
atlases, have so many layers that showing them all
at once is not practical.  The
atlas designer has to make the
decision about which layers
to make visible initially.  If
you are interested in any of
the other layers, you can turn
them on.  When a layer is
“unhidden,” it is drawn on
top of all other layers.  It is
drawn in its proper position
in the layer order the next time the view is redrawn.

Map scale controlled visibility turns layers on and
off as you zoom in and out.  Low resolution images
can be replaced by higher resolution images as you
zoom in or satellite imagery may replace a scanned
map.  Vector objects can show different levels of
detail.  With map scale controlled visibility, a layer
can always be on, it can either appear or disappear
when the specified scale is reached, or it can be vis-
ible only within a designated scale range.  The scale
field at the bottom of the view window reports the
number to the right of the colon in
the map scale (for example, 24,000
for 1:24,000).  To see the soil map in
this exercise, you have to zoom in to
1:42,000 or greater.  You cannot
change the map scale at which lay-
ers are visible in TNTatlas.  Assign-
ing map scale controlled visibility
is also up to the atlas designer.
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Viewing Database Information
STEPS

change the entry in the
scale field to 42000, and
press <enter>

find the CBSOILS layer in
the TNTatlas Layer Man-
ager window, and click
on Show Details

click on the Show
Tables icon button
in the polygon row

click on the View
Table icon button for
the CLASS and YIELD tables

click on the Select
icon button on the
view window toolbar

click on a number of
soil polygons in the
view window noting
the records selected

click on Redraw
in the view win-
dow and note that
transparency is
restored to poly-
gons that had been
selected

click on a Select
Record button in
the YIELD table then
on the Exclusive
icon button in
the YIELD table’s
toolbar (note the view will
pan if the active element
is not visible)

look at the polygon row
for CBSOILS in the TNTatlas
Layer Manager window
and note how many poly-
gons are selected

repeat steps 8 and 9 for
a different soil type

click on the Hyper
Index Navigator tool

TNTatlas provides you the same access to database
information available in TNTmips.  You can view
attributes of selected elements and use attributes to
select elements.  You can use attributes to select
elements while the HyperIndex Navigator tool is
active, but you must switch to the Select tool or the
GeoToolbox to select elements with the mouse.

The Select tool on the view window tool bar lets
you select individual elements.  In addition to in-
dividual element selection, the GeoToolbox lets
you draw geometric and irregular shapes for use in
selection.  You can make measurements using these
same shapes or create a sketch layer or region from
them (these features are described in Getting Started:

Sketching and Measuring and
Getting Stared: Interactive
Region Analysis).

If you select elements without
first opening a database table,
the first table associated with
the element type selected
opens automatically.  For
many vector objects, this table
may be the element ID table,
which is not likely to provide
information of interest to you.
You need to take the positive
actions described in this exer-

cise to open the table you want to view.  Unless you
are already familiar with the data in the atlas you
are viewing, finding the information you want to
see is an exploration process.  You show details on
groups and layers, then reveal the list of tables and
decide which to open.

Polygons with transparent fills are not returned to
their original state when unhighlighted; you need
to redraw to restore their initial appearance.  The
style field in the class table shows transparent col-
ors as the corresponding solid color.
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Web Links By Attribute
Point-and-click object retrieval in TNTatlas replaces
the current view window contents with the object
retrieved.  Any object type, including complex lay-
outs that include many different objects and scale
bars, legends, or other enhancements, can be re-
trieved as was demonstrated
in the previous exercise.
When the link is to an exter-
nal file type or web site, a
separate window opens for
that application, and the cur-
rent view remains un-
changed.

The layout for this exercise
shows a resampled mosaic of
Digital Ortho Quarter Quads
(DOQQs) for a portion of
Box Butte County as the
base for a sample of registered ground water wells in
the area.  The well points are theme mapped by
pumping capacity.  Each of the points has a link to
the data maintained by the Nebraska Department of
Natural Resources for the well represented by the
point.  Not all the points in the vector object have
their associated well log information, which can be
o b t a i n e d
from the web
site along
with owner-
ship and
other infor-
mation that
is not associ-
ated with
any of the
points in the
vector ob-
ject.

STEPS

click on the down-
and-right arrow in
the HyperIndex Naviga-
tor window, which is the
only active arrow

make sure you are con-
figured to connect to the
Internet although you
need not have launched
your browser

with the HyperIndex
Navigator tool still se-
lected, click on one of

the points (the
first retrieval
will be slow if
your browser
is not already
running)

note that
the DataTip
matches
the registra-
tion number
of the well
data re-
trieved

click on
other points



page 10

Using TNTatlas with X Windows

TNTatlas Miscellaneous Features
STEPS

click on the +
to the left of
Group 1 in
the Legend-
View

note the ap-
pearance of
the layer
names and
legends

right-click on
the MOSAICCOQ layer name
in LegendView and
choose Hide Legend
(note that only the legend
for that layer is hidden)

right click on the wells
layer name in Legend-
View and choose View
Metadata

read the metadata, then
choose File / Close in the
Metadata Viewer window

move the cursor to the
right of the vertical scroll
bar in the LegendView,
but not over
the view itself;
the cursor
should become
a double-arrow,
then click and
drag to resize
the LegendView

click on the Show Layers
arrow for Group 1
in the TNTatlas Layer
Manager

click on the Tools
icon for the MOSAICCOQ

layer and choose
Raster Histogram

note the information
presented

try other selections on
the Tool menu

The LegendView, which appears by default at the
left of the view window can be turned off, moved to
the right of the window, and resized.  The informa-

tion in the LegendView can be expanded and col-
lapsed.  With the exception of showing a legend
for each layer, the functions of the LegendView
are duplicated in the TNTatlas Layer Manager win-
dow.  The active group and layer have a surround-
ing rectangle in LegendView rather than the red
indicator used in the Layer Manager.  It is a matter

of personal preference whether you want the leg-
end information in the view window.

You will find right mouse button functions at the
group and layer level in LegendView.  Clicking the
right mouse button on the group name lets you
choose between hiding or showing layers, redraw-
ing, or zooming to the extents of the group.  The
right-mouse menu for the layers lets you hide the
legend, redraw the layer, and provides various zoom-
ing options depending on the layer type.  You can
also choose to view metadata for the layer or its
extents.  These functions and more are available
from the Tools menu for each layer in the TNTatlas

Layer Manager.  The tools menu also pro-
vides the options to view extents, object
coordinates, raster histograms, or a raster
correlation diagram.  For vector, CAD, and
TIN layers you can also zoom to the ac-

tive or selected elements.

A number of hot keys are available to make chang-
ing view position and
zoom easier.  The view
window must have focus
for these to be active: re-
draw at full view, 0; set
zoom to 1X–4x, 1–4;
recenter at cursor loca-
tion <space>, zoom in, +;
zoom out, -.
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Viewing Single Layout Atlases
The HyperIndex Navigator tool has no function with
single layout atlases.  You reveal the depths of the
atlas with the zoom and pan tools.  The hot keys
presented at the bottom of the preceding page are
also useful.  Single layout atlases rarely have all the
layers shown at one time.  The earlier exercise on
Layer Visibility describes different methods of mak-
ing layers draw without specifically using the zoom
box, which is actually the most likely method to be
used for zooming in.

The Zoom Box is used to select an area you want to
zoom up on and is proportional to your view area
(unless you have differential zooming turned on).
There is an Options / View Preferences toggle that
lets you set whether the tool is spring loaded (zooms
when you release the mouse) or right-mouse button
activated.  In the latter case, the Zoom Box remains
on the original image where it was drawn, so that its
position and size can be adjusted, until you click
the right mouse button.  Set this toggle in which-
ever position you prefer (it also applies to the Pan
tool to the right of the Zoom Box).

Most single layout atlases
are far more complex than
the layout used in this ex-
ercise, which you should
recognize as part of the
larger USA atlas.  This lay-
out, however, will serve to
demonstrate approaches to
use with single layout at-
lases.  If you see a layer
listed that you want to view but you don’t think it is
drawn, try zooming to the layer extents.  If the layer
has map scale controlled visibility, it is likely vis-
ible at this scale.  If the layer is a mosaic, for ex-
ample all the TIGER data in the state, it will not
likely be visible when you zoom to its extents.  Find-
ing a layer of interest may take some thought.

STEPS

choose File / Open Ob-
ject and select SPOTAND

OVERLAYS from the CB_SPOT

Project File

click on the Zoom
Box tool, position
the cursor at the upper
left of the raster, draw
out a box that encom-
passes at least two grid
squares in each direc-
tion, then release the
mouse

click on the Full
View icon button

choose Options / View
Preferences and toggle
on the last button (use
right mouse button to
perform zoom or pan)

repeat step 2 except
reposition and resize the
box after its initial draw-
ing, then click the right
mouse button

click on the Zoom to
Active Group icon
in the view window

click on the + to the left
of Group 1 in Legend-
View

click on the Zoom
to Active Layer icon
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